Camping and Graphic Design?! (and bears)

Story by By Emy Zettner, class of '07 • photo by Alison Conners, class of '10

Over our years at Chapman as Graphic Design students, I'm sure we've all found (or will find) that design is not simply our major; it is also a way of life. Even when we are outside the classrooms and mac labs, we tend to think like designers. For example, one night as my roommates and I were driving to a restaurant, I pointed out an eye-catching billboard and applauded the creative concept used. Then at the restaurant, I said to them, "I bet I can tell you exactly which font is used in this menu design!" I can't find the quesadillas, "there is a severe lack of visual hierarchy here." Quizzical stares follow.

At this point you’re probably thinking “Oh my gosh, that exact scenario happened to me just last night!” It’s true, we can’t escape design. This is why sometimes it may be a good idea to step away from it completely. So one day over the summer, the Graphic Design Club officers and I were thinking... “What fun, relaxing activity can we do as a club that has absolutely nothing to do with design?” We agreed a camping trip would be best—it would be a nice break from computers, printers, homework, and even the surrounding design that we encounter in everyday life.

For the third weekend in September, we reserved a campsite at Jackson Flat, Wrightwood. Fourteen of us, including our wonderful professor and club advisor Claudine Jaenichen, piled into a few cars, with camping gear and food ready to go (unfortunately our other advisor, Eric Chimenti, THE Graphic Design Guru, could not attend).

It was quite a drive (about two hours), but when we got there, it was immediately worth it. We had a wonderful little spot, complete with picnic tables, a grill, and a nice, helpful park ranger. We started by setting up our tents, and once we were done, we hiked to the visitors’ center, which was about an hour by foot. Once we were there we learned a bit about Jackson Flat, the surrounding wildlife, and were confronted by a giant stuffed bear. That night it took us about an hour to get the grill started (we’re design majors, not outdoorsmen), but once we did, we enjoyed burgers, potato salad, and other munchies. Then after a good dinner, we sat around the campfire, made smores (a camping trip necessity), and played a few ice breakers. We did need some creativity for one of the games; who could make the most creative superhero costume out of toilet paper? The results were rather interesting...and a good deal of clean-up followed (we might be pretty lax on picking up paper in our beloved graphic design lab...but we weren't about to leave paper out in nature)! The next morning we woke up, cleaned up, packed up, and, sadly, left.

It was a short time in the wilderness, but it was well worth it. We returned to Chapman rejuvenated and ready to tackle whatever design homework we had that weekend. It was good to take a break, not just from design, but from campus and our lives.

A Sad, Sad World of Commercial Art ...

I imagine a college career in which you didn’t study the much-loved graphic design. Instead, you studied commercial art—how jejune! To the lives of those who are enriched by our art, graphic design means nothing, but somehow everything at the same time. The battle with clients, the long hours at a computer screen, and the constant drafting and redrafting of a design are all complications which would have been called Commercial Art. But there was a man—his name was William Dwiggins—he saved all our careers.

In the early 1920s he coined the term “graphic design,” a phrase that would come to mean so much, to so few. He was a book designer and illustrator, as well as a typographer, printer and puppeteer. He designed approximately 400 books, 17 typefaces, and just like Gefpetto, marionettes. Your hero and mine, Mr. Dwiggins, designed three of the most widely used typefaces today: Caledonia, Metro, and Electra. 1928 was the “Year of Dwiggins,” named by Publisher’s Weekly; so named because he received the Gold Medal from the American Institute of Graphic Arts (AIGA), became a fellow of the American Academy of Arts and Sciences, and the previous year, received an honorary degree from Harvard.

Without this man, we would not be graphic designers, the lofty distinction of who can and should design from those who should stay far away. We would be 17 fonts short of a bunch. We would be commercial artists, the many, the common.

The first annual Dwiggins Award will be presented to the outstanding Graphic Design student from each class this May at the All-Department art show, held in the Guggenheim Gallery.
I was just a freshman when I was told about a logo competition for the graphic design club. Procrastinating, the night before it was due I created seven logo designs. My designs were featured at in the Guggenheim Gallery during a show opening where anyone could vote. The votes narrowed it down to two logos, Warren Wallace’s and mine. Eric Chimenti had Warren and I revise our logos. My concept was to incorporate the process of graphic design, from brainstorming to sketching to digitizing. I did this very literally with simplified outlines of a light bulb, computer, and sketches. It was brought to my attention that the computer in the logo resembled an old iMac. Frustrated I went back to the drawing board to create a more stylized depiction of the design process. I ended up going in an entirely different direction and developed the squiggly arrow logo. In the end I went with this logo that was brought to its current look by Lauren Godlove. This logo symbolized the fact that designers are all over the place when developing concepts and designs. Our designs are constantly being critiqued and tweaked to make the best possible design. There is no template or direct path for designing. As a sophomore looking back I had a lot to learn about design. Through my classes I have come to appreciate the art of thumbnails, and sketches. I was only vaguely familiar with this design process as a freshman and now I live by it. I feel the logo ended up being a great symbol of the thought processes of every graphic designer.

Is the name meant to be offensive? Isn’t compost (one m) decaying plant material used as fertilizer? Some have said they are confused about the title of this fine publication. Compostpost is a compound word. It is the combination of COMMUNICATION and POST. It is the venue where the Graphic design club and program communicate with perspective students, current students, alumni, and friends. The communication and news is AFTER or post the actual events. Thus, Compostpost communicates the news and events that have occurred in the GD program after a semester ends.

The fonts used are two of Chapman University’s corporate fonts. “Comm” is the serif font, Palatino, and the ‘post’ is the sans serif font Akzidenz Grotesk. There are also two ligatures that occur between the “mm” and between the “st.”

Every year designers send their best pieces to HOW Magazine and others like it, entering competitions for the chance to be published, the ultimate form of self-promotion. Every year, the pieces sent to HOW Magazine and others like it get thrown away after they’ve been photographed for the issue. This fall with a stroke of genius, Gina Mimms, a board member for AIGA Orange County, contacted HOW Magazine and convinced them to send all the winning entries to her. With that, the HOW Magazine Self-Promotion Awards came to Chapman University’s Guggenheim Gallery. First displayed in September at Boot Camp, a conference put on by AIGA Orange County and held at Chapman, and then in October in the upstairs room of the Guggenheim Gallery, the award-winning designs were laid out on tables for viewers to pick up, play with, and marvel at. Two days of setting up produced a wall of posters, tables of brochures, cards, books, invitations, t-shirts, and other fun items, and pedestals highlighting the very best of the winners. Also available were free copies of the HOW Magazine Self-Promotion Awards issue, a booklet about the financial state of the graphic design profession, free stickers and membership forms for AIGA.

As graphic designers and art students, we all know the importance of seeing other artists’ work—the inspiration and knowledge that spills out of the art and into our brains. “I fell in love with the Charles & Ray Eames paper series,” said Melissa Cruz, a junior Graphic Design student. “I was really jealous about that piece, would have loved that job, but wouldn’t have known what to do with it!” The collection includes a chip chart, showing available colors, in a sleeve-like envelope with laser-cut chairs that allow the color to peek through. Also included were promotional CDs, paper samples, and printed ads in the form of “fortune tellers,” those little paper toys we’ve all made. Even non-graphic design students enjoyed the show. Sarah Kellison, a freshman business major, attended the show with her roommate and her roommate’s sister. “I’m so glad I went! It was so much fun for me because I don’t usually have much exposure to that sort of thing as a Business Major. I appreciate art, but I don’t have much time for it in my life anymore. Everything was so well done and so beautiful; I really just marveled at the talent that went into making those products.” Sarah will undoubtedly come into contact with design and designers much like those exhibited at the HOW show in her future business world.

Graphic design shapes much of the world we live in. It’s everywhere from soda bottles, toilet paper, and tea bags to annual reports, wedding invitations and web sites. Despite the wide-spread exposure of the fruits of the profession, the artists behind the work are rarely praised outside the office. In fact, most of our work becomes trash in less than 6 months. Thanks to HOW Magazine and Gina Mimms, the graphic design community in and around Chapman University was able to see, touch and even smell the fruits of the industry first-hand, acknowledging the designers behind the art, and for once, not throwing it away.
Angela Glenn knows the importance of making connections and working with others in a graphic design setting, and she was keen on sharing this knowledge with the Chapman University graphic design club when she visited last fall.

“Networking starts for a designer during school. Professors and peers can help make connections and secure freelancing opportunities, but one’s superiors will only want to help those students who show exceptional punctuality, work, and were always efficient. It depends on you.”

One of the best ways for students to transition into the career environment is through an older, or someone who knows the field and can give those with less experience good tips. However, working closely with others and the valuing another’s work does not stop once fully integrated in the graphic design community.

A little over one year ago, Glenn opened an ad agency. She chose to team up with an advertising mastermind in order to make her business a success. “Many, many hands touch a project,” said Glenn to students when discussing how long print jobs can take. She also stressed the importance of understanding strategy and marketing.

“Through enthusiasm and the will to learn, you will be able to find people who want to help you. Making connections is always up to you.”

Ron Leland is the President of AIGA Orange County, including his wide range of experience and willingness to speak with and encourage graphic design students, like those here at Chapman.

“No matter how well you did at school, your first job will put you at the lowest position on the totem pole,” Leland told a group.

Leland graduated from the Cal Poly School of Architecture and gradually became interested in graphic design due to various tasks in other jobs. One day, after designing marketing materials and display boards for an architecture firm, Leland purchased a Mac computer and began designing letterheads for his employer. Although Leland did not have formal training in graphic design before that, he had an artist’s intuition and did not get discouraged by others.

“One designer pooh-poohed me for trying to design things myself. She kept saying that I don’t know anything about kerning, or leading, and I kept thinking that I had no idea what she was talking about. I just knew if it looked good or not,” he said.

Leland calls his graphic design education ‘fly by the seat of your pants learning’ and he has worked for a business of his own since 1995.

“I’m still an architecture geek,” admitted Leland. “I look at buildings, and I see graphics. The simplicity of texture, the building materials, the shapes in building a house is a lot like graphic design.”

Continuing with his architecture metaphor, Leland described how the industry gives its designers the building materials, and the designer must know these materials well so they can be dispersed according to a specific target audience.

“When you create, your job is to get someone to slow down for just a second, just long enough to be touched by the piece.”

Interested? E-mail Eric Chimenti at chimenti@chapman.edu
Switch to the Next Window
I almost always work with several InDesign document windows open at the same time and I often need to switch from one window to the next. Sure, I could use the Window menu to do this, but it’s often much faster to press Command/Control-tilde to switch to the next window Command-Shift/Control-Shift-tilde to switch to the previous window. The tilde key is in the upper-left corner of the keyboard on US keyboards. If you have a non-US keyboard, the keyboard shortcut might be different. You can customize it to whatever you want by choosing Edit > Keyboard Shortcuts, picking “Views, Navigation” from the Product Area popup menu, and finding the Next Window and Previous Window commands.

Keith Gilbert, from InDesign Magazine #7, Aug/Sept 2005

Look Back at History
If you hold down the Command/Control key while you choose About InDesign from the InDesign menu (Mac) or Help menu (Win), you’ll see the Component Information dialog box. It tells you exactly what version of InDesign you’re running and which plug-ins are installed. The Document History section of the dialog tells you when the document was first created and by what version of InDesign, when it was last saved, whether the file was ever converted from Quark or PageMaker, and other information. All of it may be useful for diagnosing a troublesome document.

Keith Gilbert, from InDesign Magazine #7, Aug/Sept 2005

Build Guide Libraries
You can save a page’s guides by selecting them and choosing Add Item from the Library’s palette menu or by clicking the New Item button at the bottom of the palette. Then, when you want to use the same set of guides on another page, simply select it in the Library and choose Place Item(s) in the palette menu. This places the same guides, in the same positions, on the new page. You can’t add to or place guides from a Library using drag and drop.

Erica Gamet, from InDesign Magazine #7, Aug/Sept 2005

Better Text Wrap
When you assign a text wrap to an imported graphic, be sure to first select the graphic with the Selection (black arrow) tool. This applies the text wrap to the frame, not the frame’s contents, which makes it easier to delete the graphic or replace it with a new graphic without deleting the text wrap.

Keith Gilbert, from InDesign Magazine Issue #7

Preview Image Moves
When moving a cropped image inside a frame, hold down the mouse button for about a second before you move the object. You’ll get a ghosted preview of the whole image in the frame.

Amie McKee, from InDesign Magazine #7

Reveal Custom Kerning
One person’s idea of appropriate kerning can be a compacted visual disaster for another person. My limit for the loosest and tightest kern is 30 (thousandths of an em). That means if some copy is kerned into -20 I will never go over +10 elsewhere in the document.

To see where kerning has taken place outside of paragraph and character styles, go to Preferences > Composition, select the Custom Tracking/Kerning option, and click OK. In normal view mode (not in preview mode), InDesign now highlights in green text with custom tracking and kerning.

Matt Doros, from InDesign Magazine #7

Convert Corner Points to Curves
Everyone knows that you can use the Direct Selection tool (the white arrow) to select a point on any frame. But did you know that if you hold down the Command and Option keys (Ctrl and Alt on Windows) you can drag on any corner point to convert it to a Bezier curve? Alternately, you can click once with those modifier keys on a curve point to convert it to a corner point.

David Blatner, InDesign Magazine and InDesignSecrets.com

Jump to the End of the Story
One of the best ways to get efficient in InDesign is to learn the keyboard shortcuts for navigating around text. For example, you probably know that Command/Control-Down Arrow moves to the beginning of the next paragraph. Here’s a few that I find many people don’t take advantage of:

* Command/Control-End jumps to the end of the current text story
* Command-Shift/Control-Shift-End selects from the current text cursor position to the end of the story, even if the end of the story is overset (past the end of the last text frame).
* Replace the Home key above to jump or select to the beginning of the story.
* Note that on some keyboards, you may have to add another modifier key. For example, on my PowerBook I have to add the “Fn” key before pressing the right-arrow key to select to the end of the story (because Fn-Right Arrow equals the End key on my keyboard).

David Blatner, InDesign Magazine and InDesignSecrets.com

Undo to your Heart’s Content
When you need to undo your way out of a problem, the last thing you want is arbitrary limits. Virtually any action you take with InDesign can be undone. Plus, it has powerful document recovery features. Restart, and it opens the document you were working on — right where you left off.

Adobe InDesign website

Did You Know...? Tricks of The Trade! InDesign Tips and Tricks!

Switch to the Next Window
I almost always work with several InDesign document windows open at the same time and I often need to switch from one window to the next. Sure, I could use the Window menu to do this, but it’s often much faster to press Command/Control-tilde to switch to the next window Command-Shift/Control-Shift-tilde to switch to the previous window. The tilde key is in the upper-left corner of the keyboard on US keyboards. If you have a non-US keyboard, the keyboard shortcut might be different. You can customize it to whatever you want by choosing Edit > Keyboard Shortcuts, picking “Views, Navigation” from the Product Area popup menu, and finding the Next Window and Previous Window commands.

Keith Gilbert, InDesign Magazine and InDesignSecrets.com

Look Back at History
If you hold down the Command/Control key while you choose About InDesign from the InDesign menu (Mac) or Help menu (Win), you’ll see the Component Information dialog box. It tells you exactly what version of InDesign you’re running and which plug-ins are installed. The Document History section of the dialog tells you when the document was first created and by what version of InDesign, when it was last saved, whether the file was ever converted from Quark or PageMaker, and other information. All of it may be useful for diagnosing a troublesome document.

Keith Gilbert, from InDesign Magazine #7, Aug/Sept 2005

Build Guide Libraries
You can save a page’s guides by selecting them and choosing Add Item from the Library’s palette menu or by clicking the New Item button at the bottom of the palette. Then, when you want to use the same set of guides on another page, simply select it in the Library and choose Place Item(s) in the palette menu. This places the same guides, in the same positions, on the new page. You can’t add to or place guides from a Library using drag and drop.

Erica Gamet, from InDesign Magazine #7, Aug/Sept 2005

Better Text Wrap
When you assign a text wrap to an imported graphic, be sure to first select the graphic with the Selection (black arrow) tool. This applies the text wrap to the frame, not the frame’s contents, which makes it easier to delete the graphic or replace it with a new graphic without deleting the text wrap.

Keith Gilbert, from InDesign Magazine Issue #7

Preview Image Moves
When moving a cropped image inside a frame, hold down the mouse button for about a second before you move the object. You’ll get a ghosted preview of the whole image in the frame.

Amie McKee, from InDesign Magazine #7

Reveal Custom Kerning
One person’s idea of appropriate kerning can be a compacted visual disaster for another person. My limit for the loosest and tightest kern is 30 (thousandths of an em). That means if some copy is kerned into -20 I will never go over +10 elsewhere in the document.

To see where kerning has taken place outside of paragraph and character styles, go to Preferences > Composition, select the Custom Tracking/Kerning option, and click OK. In normal view mode (not in preview mode), InDesign now highlights in green text with custom tracking and kerning.

Matt Doros, from InDesign Magazine #7

Convert Corner Points to Curves
Everyone knows that you can use the Direct Selection tool (the white arrow) to select a point on any frame. But did you know that if you hold down the Command and Option keys (Ctrl and Alt on Windows) you can drag on any corner point to convert it to a Bezier curve? Alternately, you can click once with those modifier keys on a curve point to convert it to a corner point.

David Blatner, InDesign Magazine and InDesignSecrets.com

Jump to the End of the Story
One of the best ways to get efficient in InDesign is to learn the keyboard shortcuts for navigating around text. For example, you probably know that Command/Control-Down Arrow moves to the beginning of the next paragraph. Here’s a few that I find many people don’t take advantage of:

* Command/Control-End jumps to the end of the current text story
* Command-Shift/Control-Shift-End selects from the current text cursor position to the end of the story, even if the end of the story is overset (past the end of the last text frame).
* Replace the Home key above to jump or select to the beginning of the story.
* Note that on some keyboards, you may have to add another modifier key. For example, on my PowerBook I have to add the “Fn” key before pressing the right-arrow key to select to the end of the story (because Fn-Right Arrow equals the End key on my keyboard).

David Blatner, InDesign Magazine and InDesignSecrets.com

Undo to your Heart’s Content
When you need to undo your way out of a problem, the last thing you want is arbitrary limits. Virtually any action you take with InDesign can be undone. Plus, it has powerful document recovery features. Restart, and it opens the document you were working on — right where you left off.

Adobe InDesign website
On the 30th of September in conjunction with AIGA Orange County and the Graphic Design Program, Adobe delivered an all day training seminar in Memorial Hall. Claudia McCue, came in from Atlanta and was the DI in charge of the training. She went through all many of the new features in Creative Suite 2. Most of the seminar dealt with the big 3: Illustrator, Photoshop, and InDesign. Claudia entertained all questions from the audience

"recruits," even answering questions during the morning, lunch, and afternoon breaks. This was the first event of its kind on the west coast. Adobe was so pleased with the turn out and outcome, they have committed to come back September 2007. Claudia had this to say via email after the event (see below).

The 19th annual How Self Promo show was on display in the lobby, and there was a Graphic Design trade show featuring print vendors, software and hardware companies, printers, paper mills, and Apple on the lawn in front of Memorial Hall to end the day. This coming fall’s event will be bigger and better. It will undoubtedly be talking about Creative suite 3 and the new integrated versions of Flash and Dreamweaver. Mark your calendars now for Saturday September 22, 2007. Please refer to http://orangecounty.aiga.org/ for all the latest news and information, and to sign up for events.

---

I have to commend you, Ron Leland and everyone else involved for setting up such a great event. The venue was fabulous, the food was wonderful...but most of all, the atmosphere was warm and lively. It’s great when people ask lots of questions, laugh and interact. That’s why I love what I do for a living! Thank you for a fun experience!

Best regards,
Claudia
Adobe Certified Instructor: Print Specialist

---

Listen up you maggots and mark those calendars!

**BOO T C A M P II**

September 22, 2007

+ EXPO brought to you by Adobe

at Chapman University

It’s the only Southern California Conference where you can find out what’s new in Graphic Design Software from Adobe. Want to find out about CS3? Dreamweaver? Flash? The new Photoshop? Mark your calendars and sign up to get your officer stripes!
Junior Graphic Design Show Draws A Crowd
Written and photography by Madeleine Pisaneschi, Class of ’10

There was a feeling of relief in the air. “I’ve been working on the Junior Show since September,” said Anneliese Herriford. “Every time I thought a project was finished, Claudine [Jaenichen] would find something that could still be improved, so I kept working up until the very last minute.”

Students and faculty alike turned out to look at the impressive creations of graphic designers Jaclyn Burris ’07, Richard Buckner ’07, Brooke Dombroski ’07, and Anneliese Herriford ’07, whose labor-intensive pieces were displayed in Chapman’s Guggenheim Gallery.

While sampling tasty cupcakes and brownies, also courtesy of the tasty cupcakes and brownies, hungry students, observers were able to learn about each of the exact requirements, or “problems” that the wide variety of artwork “solved.” The FRS energy drink was in need of a new name, audience, and look, and the redesigned version from Buckner perfectly “express[ed] a sense of energy flow and sustained growth.” Rolex would have been thrilled with the colorful and curved shape of Burris’s redesigned watch packaging, perfect for appealing to younger customers. And any company ready to print and produce Dombroski’s “HE>i” shirt designs would have benefited from both raising awareness about an important moral cause and seeing a drastic spike in their sales.

An issue close to her heart, all of the work of Brooke Dombroski was centered around the message “of homelessness, love, peace, and glory to God,” explained the junior. Every piece incorporated not only the “HE>i” logo, but also the principals behind it, from business cards in a rainbow of colors to a pair of jeans that had been skillfully completed only hours before.

Though the time that went into each new logo, poster, and card by the students was evident in the details, Jaclyn Burris gratefully noted that “I’m definitely glad that we don’t have to do a Senior Show also!”

Professors Eric Chimenti and Claudine Jaenichen spent the evening enjoying the creations of their four students: at the end of the week, designs would come off the walls for the instructors to critically analyze and grade.

“Around here, it’s known as ‘Fateful Friday,’” joked Chimenti. Yet all kidding aside, it seemed as though fate wasn’t about to stop smiling on these graphic designers any time soon.

Art student Melissa Cruz ’08 regards the designs of her peers.

Get your hands on this!

T-shirts available in green and white for only $10

To order, contact:
Eric Chimenti in MC 218A at (714) 997-6807
Claudine Jaenichen in MC 220 at (714) 744-7034
or Emmy Zettner at (619) 997-0080

Artful Exhibition Ends 2006 On A Creative Note

On December seventh, the opening reception of the Student End of Semester Art Show commenced in the crowded Guggenheim Gallery, Chapman’s own art gallery. Chapman proudly showcased its creative side for the students, faculty, and members of the public with an appreciation for imaginative expression. Each square inch of space had been covered by artwork of all imaginable styles, created by everyone from freshman to seniors.

A project completed for Digital Design, tiny, meticulously decorated model-homes stood on pedestals throughout the room, accompanied by several abstract ceramic forms. Dramatic photography and colorful paintings produced both inside and outside the classroom hung on the many of the walls. The Gallery could not have been more crammed full of art, and yet those on display for the duration of the show constituted only half of the many submitted entries.

As a student-judged event, the works were narrowed down by a variety of art majors to the most impressive entries. These final few were then organized by Justin Ostiz ’07, who oversaw much of the show’s complex production. An outside juror who had been previously selected by the students, distributed four “Best of Show” awards at the end of the evening. Among the several thrilled artists who were honored were Randi Rubin and Julie Walker, both graduating in 2008.

The event’s success left students enthusiastic and ready to begin preparing entries for next semester’s show, which will open May 10th and run through the 18th in the Guggenheim Gallery.
Part time professor David Matea balances his graphic design career, teaching at multiple Universities, and still manages to have a hobby.

If you are a student juggling college, homework, keeping a job, and keeping sane through it all, it is a difficult task, the fact that part-time professor David Matea is still on his feet is practically a miracle.

In addition to teaching the Introduction to Graphic Design course here at Chapman, Matea somehow manages to teach graphic design related courses at Otis Art Institute and CSU Long Beach, maintain his graphic design career as an Art Director at Maritz in Torrance, complete projects for other agencies in LA and Orange County, direct the creative for Ambriz Communications, a start up company formed by part in himself, and to top it all off he still manages to find the time to stay physically active, spend time with his wife, and create woodcut prints in his spare time.

With so much on his plate, there is not doubt that Matea encounters stress in the professional realm, but his way of dealing with it is by staying physically active. “I run three to four times a week. I enjoy biking, hiking and skiing and I spend time in prayer.”

Matea has been teaching for the past seven years in addition to doing graphic design professionally for the past seventeen. Some of his professional achievements include designing logo marks for UCLA’s Athletic Department and projects for the Academy Awards.

Matea’s pursuit of a graphic design education from California State University Long Beach and CSU Fullerton began because he “liked the idea of combining word and image to solve design problems and influence interpretation using god given artistic abilities.” Some of the inspirational graphic designers to influence him on this career path include designers David Carson and Herb Lubalin who helped Matea get to where he is today.

“It’s not always what you know, but more importantly, who you know,” Matea admits. He encourages his graphic design students to establish networks of their own early on.

Additional advice he would like to pass on to his students includes always striving for the creative solution and taking a creative writing class or minorning in writing.

Matea’s goals for the future include continuing to teach, he will be adding Biola University to his teaching vitae in Spring 2007, and he hopes to one day teach full time. His long term goals include continuing to make woodcut prints and retiring gracefully in Ojai with his wife and an English bull dog. Until then, it is likely you will see him around the Chapman campus as the professor for Advanced Typography in the spring.

To view some of Professor Matea’s woodblock prints, log on to www.lapasionart.com.
It wasn't just an ordinary night this past December 2nd where an evening was shared with Chapman University graphic design seniors in the home of Professor Claudine Jaenichen. Professor Eric Chimenti joined students in the adventure of traveling through the complex interchanges of freeways and bumper-to-bumper traffic to finally arrive in a little white cottage, built in 1920, located near Old Town Pasadena. At the door, guests were welcomed and happily greeted by a dog named Zion—behind him, a living room was waiting to be filled with the good company that followed. A warm, dimmed light from the kitchen confirmed a stove nurturing pots of hot apple cider and eggnog. It was obvious that this evening would witness something special.

Part of the Sweet Exchange was to bring a food dish that had a memory or story—sweet or savory. One-by-one we presented our past, present and futures—from Almond Roca that told a tale of a bond between father and son, to Dolma and Shakalkame from Armenia, from memories of family traditions, over-rated banana bread, parents-who-temp-children-to-come-home with chicken wings, fudge that a grandfather held—not to his sweet tooth—but to his heart, holiday pasta that coins a family tradition and snacks that remind people of good times with friends—it was a night of celebration and closure to a fall semester and to those graduating in December.

The following time spent on conversation, storytelling, eating foods from people we’ve gotten to know better, and a continuous, yet, spontaneous photoshoot that only a group of designers could pull off last minute, it was a world away from class-rooms and studying for finals week. A good time was had by all.